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Getting Started 

What is CTOC? 

CorporateTime Outlook Connector (CTOC) is a calendaring and e-mail messaging system that combines 
Microsoft Outlook with the scalability of CorporateTime Server and your choice of any IMAP4 e-mail server. 
Users benefit from a familiar user interface combined with the real-time calendaring of our server. 
Administrators get the security, reliability and multi-platform support of a CorporateTime solution. 
   

What's New in CTOC 3.0 

� Open another user's folders 
� Delegate Access 
� Download CorporateTime User/Resource lists 
� Synchronization Filters 
� SMTP authentication - PLAIN, CRAM-MD5 
� IMAP4 authentication - PLAIN 
� Automatic Calendar and IMAP4 server re-connection 
� Deploy and use CTOC without CorporateTime Server access 
� Server status displays 
� Support for e-mail Internet header information 
� IMAP4 alerts 
� Outlook Bar short cuts 
� New menu commands 
� Optimization and performance enhancements 
  
Note To learn more about the new features in CTOC 3.0, please refer to the release notes. 

Get Started 

To maximize the features and performance of CorporateTime Outlook Connector 3.0, certain Outlook Add-Ins 
must be modified and CorporateTime Calendar Form must be installed. 
  
Configure Add-Ins 
Install the CorporateTime Calendar Form 
Select your default service provider 
Download Global Address List 
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Ways to get assistance while you work 

Readme 
Consult the readme for install and uninstall information. 
Release Notes  
Consult the release notes to learn about system requirements, limitations and other product information. 
Screen Tips  
To learn more about a feature, position your pointer over the item and hold down the Shift and F1  key. 
  

Configuring CTOC 

Properties dialogs 

Permissions allow you to specify the access other users have to your information. 
The Forms tab allows you to install the CorporateTime Calendar Form. This form must be installed. 
The properties dialog box for CorporateTime Public Folders allow you to select the IMAP4 folders you wish to 
show or hide. 
Administration tabs are created by Microsoft Exchange and are not currently supported by CorporateTime 
Outlook Connector. 
   

Select your default service provider  

CTOC works best when it is installed as your default mail service provider. 
 
1. On the Tools  menu, click Services . 
2. Select the Delivery tab. 
3. In the Deliver new mail to the following location list, click CorporateTime. 
 

Share log on credentials for mail and 
CorporateTime Server  

Mail and CorporateTime server log on credentials can be shared with IMAP4 and SMTP servers if SMTP 
authentication is enabled. 
 
1. Right-click the Outlook desktop icon, select Properties , click Properties , and then click the IMAP4 tab. 
2. Select the Use same sett ings as my CorporateTime server  check box. 
3. Click the SMTP tab, select The server requires authentication  check box, and click Settings. 
4. Click Use same settings as my incoming mail  server , and then click OK. 
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Configure Add-Ins 

To maximize the features and performance of CorporateTime Outlook Connector 3.0, certain Outlook Add-Ins 
and preferences must be modified. Service providers like CorporateTime Outlook Connector or Exchange 
supply the Outlook client with certain Add-Ins and COM Add-Ins that extend the range and functionality of 
the application. You should remove Microsoft Exchange specific Add-Ins when running CTOC. 
 
Add-Ins  
1. On the Tools  menu, click Options. 
2. Select the Other  tab, and click Advanced Options. 
3. Click Add-In Manager . 
4. Clear the Exchange Extensions property pages  check box in the list. 
5. Select the other check boxes, and then click OK. 
  
Note If the CorporateTime Add-In is not listed, you must install it. 
  
COM Add-Ins (Outlook 2000 only)  
1. On the Tools  menu, click Options . 
2. Select the Other  tab, and then click Advanced Options . 
3. Click COM Add-Ins . 
4. Select the check boxes in the list, and then click OK. 

Install the CorporateTime Calendar Form 

The CorporateTime Calendar Form enables users to view Attendee Availability and Attendee Status. You must 
ensure the CorporateTime Calendar Form is installed in your Calendar folder. 
 
Verify the form installation: 
1. Right-click the Calendar  icon. 
2. Click Properties , and then select the Forms  tab. 
3. If CorporateTime is not listed in the box labeled Forms associated with this folder , you must install it. 
  
Automatically install  the form: 
1. Right-click the Calendar  icon. 
2. Click Properties , select the Forms  tab, and then click Manage. 
3. Select the Publish Form Automatical ly  check box. 
  
Manually install the form: 
1. Click Manage. 
2. Select Install, and the CorporateTime name and description will appear. 
3. Click Close, and the CorporateTime Calendar Form should now be listed in the Calendar Properties  dialog 

box. 
4. Select the General tab. Clear the Automatically generate Microsoft Exchange views  check box, and click 

OK. 
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Configure ASP/Domain service log on 

1. Right-click the Outlook desktop icon, click Properties , and then select Properties . 
2. Click This server requires a Domain Service check box, and then click Settings. 
3. In the Domain ID text box, type your domain ID, and then click Add  to enter a new domain host service. 
4. Click OK. 
  

Configure SMTP authentication 

CTOC supports SMTP authentication (SMTP AUTH LOGIN) using base 64 encoding and SASL mechanism for 
SMTP authentication (PLAIN, CRAM-MD5) that require users to log on using their Account Name and Password. 
 
1. Right-click the Outlook desktop icon, select Properties , click the Services  tab, and then click Properties. 
2. Click the SMTP tab, select The server requires authentication  check box, and click Settings. 
3. Click Log on using , and enter your Account Name and Password . 
4. Select the Save this password in your password l ist check box to avoid entering your password every time 

you log on. 
5. Click OK. 

Configure Free/Busy lookup for SMTP mail 
recipients 

CTOC supports the Free/Busy lookup feature for contacts who are not CorporateTime users. 

1. Open or create a new contact. To create a new contact, on the File menu, select New, and then click 
2. Contact . Enter your contact information. 
3. Click the Details  tab. 
4. Under Internet Free-Busy , in the Address box, type the name of the server, FTP or URL where your    

contact your's free/busy information is stored. 
5. Click Save and Close. 
 

Subscribe to IMAP4 Folders 

CorporateTime Outlook Connector enables you to subscribe or unsubscribe from IMAP4. Subscribing to an 
IMAP4 folder lets you view or expand folders in the Folder List. Unsubscribing hides the folder in the Folder 
List. 
 
1. If the Folder List is not visible, on the View menu, click Folder List. 
2. Right-click CorporateTime - Public Folders . 
3. Select Properties for CorporateTime - Public Folders . 
4. Click the IMAP4 Folders  tab, and select the folders you would like to subscribe or unsubscribe from.  
5. Double-click on a folder to expand it in the list. 
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6. Use the Hide or Show Sub-Tree and the Show or Hide Sub-Tree  button to toggle back and forth. 
7. Click OK. 
 
OR 
 
1. On the Tools  menu, click IMAP4 Folders , and then select Subscribe/Unsubscribe . 
2. Select the folders you would like to subscribe or unsubscribe from.  
3. Double-click on a folder to expand it in the list. 
4. Use the Hide or Show Sub-Tree and the Show or Hide Sub-Tree  button to toggle back and forth. 
5. Click OK. 
  
Note To reset the folder list, on the Tools  menu, select IMAP4 Folders , and select Reset Folder List. 
   

Configure PDA Conduit support 

1. Right-click the Outlook desktop icon, click Properties , and then select Properties . 
2. Click the Advanced  tab, and then click Third-Party Software. 
3. Select the Pocket Mirror  or Pocket Journal check box. 
4. Click OK. 

 
Conduit Software Vendor  Device 
PocketMirror (2.04) Chapura Palm Series (3COM) 
PocketMirror (3.0) Chapura Palm Series (3COM) 
PocketJournal Chapura Palm Series (3COM) 
Desktop To Go 2.5 DataViz Palm Series (3COM) 
PSIWin 2.3 Psion Psion Devices (except Revo) 
PSIWin 2.31 Psion Psion Revo 
ActiveSync 3.0 Microsoft Win CE 3.0 (except Pocket PC) 
ActiveSync 3.1 Microsoft Pocket PC enabled devices 
  

Permissions and Delegate Access 

Set sharing permissions for folders 

1. If the Folder List is not visible, click the View menu, click Folder  List, and then select the folder you want 
to share with another person. 

2. Right-click the folder you want to share, and then select Properties . 
3. Select the Permissions  tab. 
4. Click Add . 
5. In the Name box, type the name of the person you would like to grant sharing permissions, or click 

Address Book to select a name from the list. 
6. Click OK. 
7. In the Name box, select the name of the person you just added. 
8. In the Roles  box, select the permissions you would like to assign, or use the Permissions  box to assign 
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custom permissions to the user. 
9. Click OK.  

Open another user's folders 

CorporateTime Outlook Connector enables you to open and view the folders of CorporateTime users that have 
granted you sharing or delegate access. The folders of other users will be displayed in a separate window and 
the name of the folder owner will appear in the window's title bar. Supported folders are: Calendar, Inbox, 
Journal, Notes and Tasks. 
 
1. Click the icon corresponding to the type of the folder you would like to open. 
2. On the File menu, click Open , and then click Open User's Folder . 
3. In the Name box, type the name of the person who granted you sharing or delegate access permission, or 

click Name to select from the list. 
4. In the Folder  list, select the folder you would like to open. 
5. Click OK. 
  
Note You can only access the folders of other users while working on-line. CorporateTime Server 5.0 or later is 
needed to access the data of other users. You will also need an IMAP4 server with support for Access Control 
List (ACL) is needed to access the e-mail of other users. 
  

Delegate Access 

Granting Delegate Access enables you to provide CorporateTime users with access to your Calendar, Tasks, 
Notes, Journal and Inbox. You must connect to the network in order to grant Delegate Access. 
 
1. On the Tools  menu, click Options , and then click the Delegates  tab. 
2. In the Delegates  box, select the delegate name, or click Add  to select from the list. 
3. Click Permissions and then use the drop-down list to assign Delegate Access to your Calendar, Inbox, 

Journal, Notes and Tasks. 
  
Note To send e-mail on your behalf, a delegate requires access to an IMAP4 server with support for ACLs. 
Assigning the role of Editor grants the delegate full designate rights. 

 

Meetings 

Create a meeting 

1. Click the Calendar  icon. 
2. On the Actions  menu, select New Appointment. 
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3. Enter the Subject, Location , Start t ime, and End t ime. 
4. Select the Attendee Availability tab, and click Invite Others . 
5. Select an attendee or resource list from the Show Names from the list. 
6. Enter the name in the Type Name box, or select the attendee or resource name from Select from list. 
7. Select Required , Optional  or Resource , and click OK. 
8. Click Send . 

Create a recurring meeting 

1. Click the Calendar  icon. 
2. On the Actions  menu, select New Appointment. 
3. Enter the Subject, Location , Start t ime, and End t ime. 
4. Select the Attendee Availability tab, click Recurrence , and enter the recurrence pattern and range of 

recurrence details, then click OK. 
5. Click Invite Others . 
6. Select an attendee or resource list from the Show Names from the list. 
7. Enter the name in the Type Name box, or select the attendee or resource name from Select from list. 
8. Select Required , Optional  or Resource , and click OK. 
9. Click Send . 

Invite an external attendee to a meeting 

CTOC enables you to invite non-CorporateTime users to meetings by sending them e-mail notifications. iCal 
notification must be enabled to invite non-CorporateTime users to meetings. 
 
1. Click the Calendar  icon. 
2. On the Actions  menu, select New Appointment . 
3. Enter the Subject, Location , Start t ime, and End t ime. 
4. Select the Attendee Availability tab, and click Invite Others . 
5. Select an attendee or resource list from the Show Names from the list. 
6. Enter the name in the Type Name box, or select the attendee or resource name from Select from list. 
7. Select Required , Optional  or Resource , and click OK. 
8. Click Send . 
  
Note If you are running Outlook 98, please contact your system administrator to configure iCal notification. 
Support for external attendees is only available when running CTOC on CorporateTime Server 5.1. 
   

E-mail notification on meeting creation 

1. Click the Tools  menu, select Options , and then click Calendar Options . 
2. Click CorporateTime, select the Send e-mail notification to attendees when a meeting is created or 

updated check box, and then click OK. 
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iCal notification on meeting creation 

1. Click the Tools  menu, select Options , and then click Calendar Options . 
2. Click CorporateTime, select the Automatically send iCal notification to non-CorporateTime attendees  

check box, and then click OK. 

Set Can't Book Me support 

1. Click the Calendar  icon. 
2. On the File menu, click Folder , and then click Properties for Calendar . 
3. Select the Permissions tab, and clear the Can invite me to meetings  check box. 
4. Click OK. 
  
Note This feature is only available when CTOC 3.0 is connected to CorporateTime Server 5.1.  

Download Global Address list 

1. Click the Tools  menu, select Options , and then click Calendar Options . 
2. Click CorporateTime, select the Load Global Address Lists when working on-line check box , and then 

click OK. 
  
Note If you do not download the global address list you will have to search for each user or resource when 
creating a meeting. 

Update CorporateTime User and Resource lists 

1. Right-click the Calendar  icon, select Properties  and click on the Administration  tab. 
2. Then, click Reset. 
  
Note Updating the CorporateTime user and resource lists enables you to obtain the most recent list available 
on the server.  

 

Events and Tasks 

Create an All Day Event 

1. Click the Calendar  icon. 
2. On the Actions  menu, select New All Day Event. 
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3. Enter the Subject, Location , Start t ime, and End t ime. 
4. Select the Attendee Availability tab, and click Invite Others . 
5. Select an attendee or resource list from the Show Names from the list. 
6. Enter the name in the Type Name box, or select the attendee or resource name from Select from list. 
7. Select Required , Optional  or Resource , and click OK. 
8. Click Send . 
   

Create a Task Request 

1. Click the Task icon. 
2. On the Actions  menu, select New Task Request. 
3. Click To , and enter the name in the Type Name box, or select a name from Select from l ist. 
4. Enter a Subject, Due date, Start Date, Status , Priority  and then enter the Task details in the window. 
5. Click Send . 
   

Working Off-line 

Select folders for off-line synchronization 

Automatic single folder synchronization  
1. Right-click the folder you want to synchronize, select Properties , and then click the Synchronization tab. 
2. Select the Can be used off-line check box, and then click OK. 
 

Automatic multiple folder synchronization  
1. On the Tools  menu, select Synchronize , and then click Off-line Folder Settings. 
2. Select the check box next to the folder(s) you want to synchronize. You may also double-click on a folder 

to expand it in the list, and then select the sub-folder you want to synchronize. 
3. Click OK. 
  
Manual folder synchronization  
1. On the View menu, select Folder List, and then click the folder you want to synchronize. 
2. Click the Tools  menu, point to Synchronize , and click This Folder  or All Folders . 
  
  
   

Off-line folder passwords 

1. Right-click the Outlook desktop icon, click Properties, and then select Properties . 
2. Select the Startup  tab, click Off-line Folder Settings, and select Change . 
3. In the New Password text box, type a password, and then type the same password in the Confirm 

Password text box. 
4. Select the Save this password in your password l ist check box to avoid entering your password every time 

you log on. 
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5. Click OK. 
  
   

Synchronization filters 

1. On the Tools  menu, select Synchronize , and then click Off-line Folder Settings. 
2. Click the folder you want to filter, and then click Filter Selected Folder . 
3. Select the filter options you want. 
4. To filter using additional criteria such as a category or importance level, click the More Choices  tab, and 

then select the options you want. 
  
Note Synchronization filters can only be edited while connected to the network. 
   

Work off-line 

1. Right-click the Outlook desktop icon, click Properties , and then select Properties . 
2. Click the Startup  tab, select the Enable off-l ine use check box, and click Work off-line. 
3. Select the Choose a connection type check box to enable CTOC to prompt you to Connect to the network, 

or Work off-line before opening Outlook. 
4. Click OK. 

Change the location of off-line files 

1. Right-click the Outlook desktop icon, select Properties, and then click Properties . 
2. Click the Startup  tab, and then click Off-line Folder Settings. 
3. Enter the desired location of your off-line file, or click Browse to select a location. 
4. Click OK. 
   

Configure off-line synchronization 

1. Right-click the Outlook desktop icon, select Properties , and then click Properties . 
2. Click the Startup  tab, and then select the Enable off-line access  check box. 
3. Do one of the following: 
� To automatically synchronize folders when closing CTOC, select the When on-line, synchronize all folders 

upon exiting check box, and then click OK. 
� To automatically synchronize folders at a specified time interval, click the When on-line, automatically 

synchronize all off-line folders check box, select a time interval, and then click OK. 
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Add CorporateTime Users and Resources 

1. On the Tools  menu, select Synchronize , and then click Off-line Folder Settings. 
2. Click Settings. 
3. In the Off-line Address Bo ok window, click Address Book. 
4. Type the name of the user you want to select or choose from the list, and then click Off-line. 
  
   

Outlook with CorporateTime  

Collaborate with CorporateTime native clients 
CorporateTime Outlook Connector allows Outlook users to manage their time and activities effectively in 
collaboration with users of any CorporateTime native client on the same network. 
The interoperability of Outlook and CorporateTime involves a few minor issues of translation. Click one of the 
following links for details: 
� Outlook/CorporateTime mapping 
� Importance levels 
� Sensitivity/Access levels 
� Ownership 
� Tentative meetings 
� Recurrences 

Importance levels 

From client to server: 
Outlook CorporateTime 
High High 
Normal Normal 
Low Low 

From server to client: 
CorporateTime Outlook 
Highest High 
High High 
Normal Normal 
Low Low 
Lowest Low 
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Outlook/CorporateTime mapping 

From client to server: 
Outlook CorporateTime 
Meeting Meeting 
Appointment Meeting (with no other people or Resources invited) 
All-day Event Day Event 
Holiday Day Event 
Task Task 
Recurring Meeting, All-day Event Repeating Meeting, Day Event 
Recurring task Unconnected (non-Recurring) Tasks 

From server to client: 
CorporateTime Outlook 
Meeting Meeting 
Day Event All-day Event (time shown as Busy) 
Daily Note All-day Event (time shown as Busy) 
Holiday All-day Event (time shown as Free) 
Task Task 
Repeating Meeting, Day Event or Daily Note Unconnected (non-Recurring) Meetings and All-day 

Events 
  
 

Ownership 

CorporateTime Server keeps a record of ownership — similar to Outlook's idea of organizers — for every item 
added to its database. Only the original creator of an entry is allowed to modify or delete that entry unless the 
user has Delegate Access or Sharing Permissions. If you open a meeting or event organized by someone else, 
you may only change the reminder setting. 
If you attempt to delete a meeting or event that you do not own, it will disappear from your Calendar, but will 
not be not removed from the server database. Instead, your attendee status will be set to Declined, and the 
meeting or event will remain in your Deleted Items folder. 
If you attempt to move a meeting or event that you do not own by clicking and dragging it to a new time, the 
original version will remain in your Calendar as originally proposed. A copy, owned by you, will be created 
according to your new specifications, to which all original attendees will be invited. Outlook will prompt you 
with the following message: 
You may want to let the meeting organizer know you changed the meeting "Title". If the 
meeting organizer sends an update for this meeting, your changes will be lost. Is this 
OK? 
Since you are not modifying the original meeting or event, but rather creating a new one, your copy will not be 
deleted if the original organizer sends an update. Click OK. 
Outlook will now prompt you with the following message: 
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Your changes could not be saved because you don't have permission to modify some or 
all of the items in this folder. Do you want to save a copy of this item in the default 
folder for the item? 
Click Yes to create your altered copy of the original meeting or event. Click No  to return to your Calendar 
without creating the copy. 
Changing a meeting or event's free/busy display, reminders, and privacy level by using the right-click pop-up 
menu will not create a new copy. In this case, however, your changes will be lost if the organizer sends an 
update. 
 

Sensitivity/Access levels 

From client to server: 
Outlook CorporateTime 
Normal Normal 
Private Personal 
Personal Personal 
Confidential Confidential 

From server to client: 
CorporateTime Outlook 
Public Normal 
Normal Normal 
Personal Private 
Confidential Personal 
  

Recurrences 

When you create recurring meetings and events in Outlook, users of CorporateTime native clients will be able 
to view these Calendar entries as Repeating Entries. 
However, Outlook will display Repeating Entries created with CorporateTime native clients as individual, 
unconnected meetings and events. All instances of the meeting or event will be present in the Outlook 
Calendar, but they will only be accessible separately. 
The ability to create a recurring task is currently not supported by CorporateTime Outlook Connector.  

Tentative Meetings 

A Tentative Meeting created with a CorporateTime native client will appear in the Outlook Calendar as a 
normal meeting, with its time shown as busy. 
If you tentatively accept a meeting with Outlook, users of the native clients will see your response to the 
meeting as I  will accept, but I would prefer another time. Similarly, meetings to which native client users have 



 19

responded with I  will accept, but I would prefer another time will appear as tentative within Outlook. 
  
  

Attendee availability 
Whenever you plan a meeting or view attendee availability, CorporateTime Outlook Connector automatically 
downloads the free/busy information for each attendee from the CorporateTime Server's calendar database, 
and displays it in the time-line. 
Accepted meetings will appear as busy, tentative or out-of-office time, depending on your selection. 
Unconfirmed meetings (which have been scheduled but not yet accepted by the invitees) will appear with white 
cross-hatching.  

Attendee response 
When using Outlook with CorporateTime Outlook Connector, you will be able to see up-to-date responses 
from all attendees of meetings and events that you have created. These responses are automatically updated 
from CorporateTime Server's calendar database when viewing the Attendee Availability tab of a meeting or 
event that you have created. 
You will not have to enter or change these responses yourself; CTOC takes care of it all for you, in real time.  

CorporateTime Server 
Microsoft Exchange is not a calendar server. It relies on e-mail messages for the distribution of events and 
meeting requests to multiple separate Calendar folders located in various places on the server. 
CorporateTime Server, by contrast, is a dedicated calendar server with a centralized database containing the 
complete calendars of all networked users. Therefore, users can view their colleagues' availability and 
responses for meetings in real time. 
  
  

CorporateTime UID log on support 
UID Log on support extends the range of Account Name formats that can be used to log on to the 
CorporateTime Server. To enable UID Log on support, please contact your server Administrator.  

Deleted Items 
When using CorporateTime Outlook Connector, all Calendar entries that you delete or decline will be moved to 
your Deleted Items folder. CorporateTime native clients will display your response to these meetings as 
"Refused". 
If you remove a meeting or event from your Deleted Items folder, it will be removed in its entirety from the 
CorporateTime Server. The Calendars of all attendees will be updated with the deletion. 
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Install the CorporateTime Add-In 
The CorporateTime Add-In must be installed in order for CorporateTime Outlook Connector to function 
properly. 
 
To get to the Add-In Manager dialog box: 
1. On the Tools  menu, and click Options . 
2. Click the Other  tab, and select Advanced Options . 
3. Click Add-In Manager . 
4. Click Install. 
5. In the Install Extension dialog box, click the file "cstms.ecf". If this file is not present, you may have to re-

install CTOC. See the readme file for instructions. 
6. Ensure that the CorporateTime option is selected within the Add-In Manager list box. 

Network log on with one server 
CTOC enables you to log on when either the IMAP4 or CorporateTime Server is unavailable. If both servers are 
unavailable, you will be prompted to work off-line.  

Off-line folder support 
With CTOC, you can manually or automatically synchronize folders. In addition, CTOC allows you to start the 
program in on-line or off-line mode, select the location of your off-line storage file and password protect 
your file. 
Configure off-line synchronization 
Select folders for off-line synchronization 
Off-line folder passwords 
Work off-line 
Change the location of off-line files 

Assign Permissions 
CTOC allows you to customize the level of viewing access other users have to your tasks and Calendar. 
 
1. Click the File menu, point to Folder , and click Properties . 
2. Click the Permissions  tab, select a person from the list box, or click Add  to choose another user. 
3. Select a role for that person from the drop-down list box. Owner  gives the selected user full viewing 

rights (using CorporateTime native clients only); None completely blocks the selected user from seeing 
any tasks or Calendar entries. Custom  allows you to mix and match settings according to sensitivity level. 
In the Calendar folder, Times Only  allows the selected user to view the times of your meetings, but no 
details or other information. 
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The IMAP4 e-mail server 
Users of Outlook with Exchange may be familiar with the Post Office Protocol (POP) style of e-mail delivery. 
With this model, e-mail is delivered to a central POP server. When you connect to this server using a client 
application such as Outlook, all your mail is immediately downloaded to your local machine and deleted from 
the server. All further processing of e-mail, including opening, moving and deleting, is carried out locally on 
your computer. 
With the Internet Message Access Protocol (IMAP) however, all e-mail remains on the server until you expressly 
remove it. You access, manipulate, and create mail folders on the server as if they were stored locally on your 
machine. 
For users who routinely access their mail from multiple sources — for example, their computer at work, their 
computer at home, and a laptop when traveling — IMAP servers are far more convenient than POP servers. 
Since e-mail is deleted from the POP network server after you sign in, those messages will be inaccessible if 
you sign in again using a different machine. With the IMAP delivery model, your e-mail will still be on the 
server, allowing you to re-read, edit, and forward messages from any machine. 
All non-Calendar and non-Task information previously stored on the Microsoft Exchange Server is stored by 
CTOC in folders on the IMAP4-compliant e-mail server. This limits the contents of these folders to mail items 
only. 
  
  

Real-time calendaring 
With CorporateTime Outlook Connector, Outlook users can access the powerful real-time calendaring and 
scheduling capabilities of CorporateTime Server. 
Real-time scheduling means that whenever a meeting or event is scheduled, the calendars of all attendees are 
automatically and immediately updated. This is possible through CorporateTime Server's centralized calendar 
database. No longer are users' calendars maintained individually in their own folders, requiring them to check 
their e-mail before new entries get scheduled. With CTOC, their calendars are incorporated, and are updated 
with new entries on the server instantly. 
In addition, user of CorporateTime Outlook Connector can view the times at which other users have been 
scheduled for meetings, even before those meetings have been accepted. This feature eliminates a major 
problem inherent in message-based calendaring: the lag between scheduling a user for a meeting and being 
able to view that meeting in the other's calendar. 
Real-time scheduling also guarantees up-to-date information on Attendee Availability and Attendee 
Responses.  
  

Refresh 
Pressing F5 or selecting the Send and Receive command refreshes your folders with new information on the 
server. This command has multiple functions with CorporateTime Outlook Connector: 
 
� Refreshing your Inbox with newly-arrived e-mail and Calendar entries 
� Sending any remaining messages in your Outbox 
� Refreshing your Calendar with new changes 
� Refreshing your Deleted Items by removing any Calendar Events that you have declined or deleted, or that 

have been deleted by their Owners.  
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Rules 
Server-side rules require the Microsoft Exchange Server, and cannot currently be set or carried out when 
running CorporateTime Outlook Connector. This includes all server-side options formerly available using the 
Rules Wizard, as well as the Out of Office Assistant. 
Client-side rules, however, will function normally.  

Security 
CorporateTime Outlook Connector users benefit from SMTP and IMAP4 authentication if these mechanisms are 
supported by the server.  
SMTP Authentication - PLAIN, CRAM-MD5 and LOGIN  
IMAP4 Authentication - PLAIN and CRAM-MD5 
   

Update folder contents 
1. Right-click the desired folder, click Properties , and then select the Adminis tration  tab. 
2. Then, click Reset. 

Where did my Contact's attachment go? 
Although they can be added normally, CorporateTime Outlook Connector does not currently support the 
ability to save attachments with Contacts.  

Why can't I AutoPreview my messages? 
When AutoPreview is selected, Outlook opens up the local copies of all messages within the current folder, and 
displays the first three lines of each message. 
IMAP-compliant e-mail servers, however, like the one that works with CorporateTime Outlook Connector, only 
download the headers of your messages, leaving the full text stored on the server. Therefore, no local copies 
exist for Outlook to open. 
It is still possible to select AutoPreview from the View menu, but the folder display will continue to show only 
the headers of your messages. 
CorporateTime Outlook Connector does however implement the Preview Pane.  

Why can't I see Category headers? 
CorporateTime Outlook Connector does support the ability to view your messages by category within all 
folders. However, the expandable row separators normally shown in this view are created by Microsoft 
Exchange, and are not implemented in this release of CorporateTime Outlook Connector.  

Why can't I specify certificates for Contacts? 
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CorporateTime Outlook Connector does not currently implement the same security features as Microsoft 
Exchange. Certificates (digital ID's) are not available for use in this release.  

Why doesn't my contact's Journal tab work? 
The Journal tab is currently unavailable when viewing contacts using Outlook 98.  

Why can't I customize my current view? 
The current view can be customized in any way permitted by the View Summary dialog box (View, Current 
View, Customize Current View). The sole exception is that no grouping features are implemented in this 
release of CorporateTime Outlook Connector. 
If you attempt to change the settings in the Group By dialog box, you will receive the following message when 
you click OK in the View Summary: 
The sorting or group by operation failed. Either these folders do not support sorting or the conditions are too 
complex. Sorting and group by settings have been reset. 
Ensure that the Group By  value in the View Summary dialog box is set to None before clicking OK. 

Why can't I detect and repair a folder? 
CorporateTime Outlook Connector does not currently support the Inbox Repair utility.  

Why can't I use Mail Merge? 
The ability to merge contact lists with external Word files is not supported in this release of CorporateTime 
Outlook Connector.  

Why can't I set reminders on my messages? 
The ability to set reminders on mail messages is not supported in this release of CorporateTime Outlook 
Connector.  

Why can't I change a Meeting into an All-Day 
Event? 
The ability to change a Meeting into an All-day Event and an All-day Event into a Meeting is not supported in 
this release of CorporateTime Outlook Connector.  

Why can't I recall a message? 
The Message Recall relies on the Microsoft Exchange Server. It is therefore unavailable when using 
CorporateTime Outlook Connector.  
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Why can't I move/rename/delete this folder? 
CorporateTime Outlook Connector does not allow you to move, rename or delete any of the "special" Outlook 
folders: 
� Outlook Today 
� Inbox 
� Calendar 
� Contacts 
� Tasks 
� Journal 
� Notes 
� Deleted Items 
� Sent Items 
� Outbox 
� Drafts 
 
Other folders may be modified.  

Why can't I create a new distribution list? 
The ability to create new e-mail distribution lists is supported by CorporateTime Outlook Connector, but the 
File menu command New, Distribution List is an extension of Exchange, and consequently is not available. 
To create a new distribution list, you must have a Personal Address Book set up in your user profile. For more 
information, see the Microsoft Outlook on-line help.  

Why can't I create a new folder? 
New folders you create in your CorporateTime profile or in a public folder on the e-mail server may only 
contain mail items. Ensure that the "Folder contains:" field of the Create New Folder dialog box is set to "Mail 
Items" before clicking OK. 
Personal folders you create locally on your machine may contain any kind of items.  

Why can't I view attendee availability and 
response? 
If you cannot view attendee availability or attendee response (for Meetings and Events that you have created), 
it is possible that the CorporateTime Calendar Form is not correctly installed 
For more information, click here. 
   

Why can't I set reminders on recurring meetings? 
The ability to set reminders for recurring meetings, appointments and events is not supported in this release 
of CorporateTime Outlook Connector.  



 25

Why can't I delete an attachment from a task? 
The ability to delete attachments from tasks is not supported in this release of CorporateTime Outlook 
Connector.  

Why can't I attach an OLE object? 
The ability to set an OLE-style attachment is not supported in this release of CorporateTime Outlook 
Connector.  

Why can't I get read and delivery receipts? 
CorporateTime Outlook Connector will process your requests for read and delivery receipts normally. However, 
these requests may or may not be honored by the IMAP e-mail server and the SMTP e-mail delivery server that 
handle your messages on the way to their destination. 
Some mail servers cannot process read and delivery receipts. Others with virus checking software installed 
may consider the code for your request to be a potential virus hazard, and delete it. 
If you are not receiving read and delivery receipts, see your system administrator.  

Why can't I recover deleted items? 
The ability to recover deleted items is an extension of Microsoft Exchange that is currently not supported by 
CorporateTime Outlook Connector.  

Why can't I send a link to this folder? 
The File menu command "Send Link to this Folder" is currently unavailable with CorporateTime Outlook 
Connector.  

Why can't I set additional Send Options for new 
messages? 
The ability to set formatting, delay and expire options using the Send Options dialog box is not currently 
supported by CorporateTime Outlook Connector.  

Why can't I set a birthday for a Contact? 
Defining contact birthdays is not currently supported by CorporateTime Outlook Connector.  

Why can't I see text formatting in e-mail I 
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receive? 
CorporateTime Outlook Connector does not support Microsoft rich-text (RTF) formatting. If a message is sent 
in RTF, it will be displayed in your folders without formatting as plain text. 
If you create and send an RTF message, CorporateTime Outlook Connector will convert your text to HTML to 
preserve your text formatting. 

Why can't I use voting buttons? 
Voting buttons are not supported in this release of CorporateTime Outlook Connector.  

Why didn't I get a reminder? 
Reminders for recurrences of meetings and events are not available in this release of CorporateTime Outlook 
Connector.  
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